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IX. Editing Tools/Commands 
 
 
 
Erasing Objects 
 
 
All the selection methods that have been discussed so far can be used with the following commands when 
the Select objects: prompt is presented. 
 
 
 
To invoke the erase command, select Erase from the from the Modify menu, the Erase icon from 
the Modify toolbar, or at the command line type erase or e.  Use one of the selection methods to 
create a selection set of objects to be erased.  When finished with selection, hit <enter> and the 
objects will be erased.  If you find that you erased something that you did not want to erase, you can restore 
the entire selection set that was removed by the most recent use of erase by typing oops and <enter> on 
the command line.  Practice erasing and restoring objects from the bransonAML drawing. 
 
 
 

 
 
 
window selection    selected objects    result 
 
 
 
After typing oops, <enter> at the command prompt the erased objects 
are restored. 
 
 
 
 
Undo/Redo 
 
Quite often while drawing in AutoCAD you want to try something but are not sure if it is what you want or 
you simply discover that you have made a mistake and want to start over back to a certain point.  The 
UNDO command is great for this. You can undo your most recent action or actions.  When invoked at the 
command line you have several options. 



 54 

 
 
Typing a number and <enter> will  undo the specified number of preceding operations.  This is 
the same as entering u at the command prompt multiple times or clicking on the undo icon, 
located on the standard toolbar, the specified number of times.  At the Enter the number of 
operations ... prompt if you type c and <enter>, you bring up the following prompt. 
 

 
 
 
 
 
 
 

 
Most of the time you want this set to all, which enables the full UNDO command.  If set to none, it turns 
off the u and UNDO commands and discards any UNDO command information saved earlier in the 
drawing.  If you attempt to use UNDO when the none option is in effect, you will get the control option 
prompt.  If the one option is chosen, UNDO is limited to a single operation, the same as typing u or 
clicking the toolbar icon. 
 
Another useful option is mark and its associated back option.  At the Enter the number of operations ... 
prompt if you type m or mark and <enter>, you place a mark in the undo information. Now if you 
continue drawing operations and then invoke undo at the command line and type b or back, you will undo 
all the work done back to this mark.  If you undo one operation at a time, AutoCAD informs you when you 
reach the mark.  When you see Mark encountered on the command line, you have undone everything up to 
that point and the mark is erased.  If you want to go forward again and you think that you may want to 
come back to this point, create another mark to replace the one just eliminated.  You can place as many 
marks as necessary.  Back moves back one mark at a time, removing the mark.  If no mark is found, back 
displays the following prompt: 

 
 
Enter y or n or press <enter>. 
 
Entering y undoes every operation in the current drawing since you opened the file. Entering n causes 
AutoCAD to ignore the Back option.  A mark stops multiple UNDO operations if the number entered is 
greater than the number of operations since the mark. 
 
 
There are some important differences between the OOPS and the UNDO commands.  Immediately after 
ERASE, either OOPS or UNDO restores the erased objects. OOPS, however, can be entered at an arbitrary 
later time (as long as nothing else has been erased), while UNDO operates strictly in reverse sequence. 
After the BLOCK command, OOPS and UNDO have very different effects: both bring the deleted objects 
back to life, but UNDO removes the new block definition as well. 
 
A multiple UNDO (using the Back option or a number, or undoing a group) regenerates or redraws if 
necessary. This occurs at the end of the UNDO; therefore, UNDO 5 will cause at most one regeneration, 
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while U U U U U could cause as many as five.  Some commands (LINE, the DIM commands, TRIM, and 
EXTEND, for example) have their own Undo options.  These step back one operation at a time.  However, 
once you exit the command, U will undo the entire command. 
 
If PEDIT began by converting a line or arc to a polyline, PEDIT's Undo option will not reconvert it.  To 
undo that, exit PEDIT and enter u. 
 
There are certain commands that UNDO has no effect.  Some of the more important ones are: SAVE, 
SAVEAS, QSAVE, REDRAW, REGEN, PLOT, AREA, DIST, HELP, LIST, OPEN, NEW, AND 
RECOVER.  For a complete list check out UNDO in AutoCAD Help. 
 
 
The REDO command reverses the effects of the previous UNDO or U command  REDO only 
reverses the effects of a single UNDO or U command. REDO must immediately follow the U or 
UNDO command.  To invoke REDO, type redo and <enter> at the command prompt or click 
on the redo icon on the standard toolbar next to the undo icon. 
 
UNDO and REDO are also available on the cursor menu that is brought up when you right-click in empty 
drawing space with no commands active or no objects selected. 
 
In the bransonAML drawing, use UNDO to place a mark in the drawing.  Now, make changes in the 
drawing and use the various options of UNDO to see their effect.  Also, try out the REDO command 
immediately following the use of UNDO. 
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Breaking Objects 
 
 
You can remove part of an object with the BREAK command.  You can break lines, circles, arcs, polylines, 
ellipses, splines, xlines, and rays.  When breaking an object, you can either select the object at the first 
break point and then specify a second break point, or you can select the entire object and then specify the 
two break points.  To start the command, type break, then <enter> on the command line, or select 
Break from the Modify menu, or select the break icon on the toolbar.  
 

 
Zoom in on parcel 22332 and break the east property line at a couple of points to remove a section of the 
line. First set a mark with UNDO.   Type break, <enter> on the command line or select the break icon and 
pick the east property line.  If you want your first break point to be where you picked, hit <enter> to get the 
prompt Specify second break point:.  Alternatively, if you want to select the first break point type f, <enter> 
and pick the point.  If your cursor wants to snap to either endpoint or the midpoint and you do not want 
these points as your first break point, turn off osnaps by pressing the OSNAP button on the status bar.  
 
 
 
 
  
Once the first point is picked you will be prompted for the second break point.  Pick it.  If you wanted to 
remove the rest of the line from the first break point on, pick the second break point beyond the endpoint of 
the line in the direction of the end you want to remove. 
 

 
 
 
 
 
 
 
 
 
 
 
 
If you want to break an object at the same point thereby not leaving a gap, just choose the same point for 
the first and second point.  The use of osnaps is quite useful for this or if you don’t want to break at a 
control point, type @, <enter> at the prompt for the second break point and the object will be broken at the 
first break point.  Before proceeding, type undo, <enter>, then b, <enter> to undo back to your mark. 
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Offsetting Objects 
 
Offsetting creates a new object that is similar to a selected object but at a specified distance.  You can offset 
lines, arcs, circles, 2D polylines, ellipses, elliptical arcs, xlines, rays, and planar splines.   Offsetting circles 
creates larger or smaller circles depending on the offset side.  Offsetting outside the perimeter creates a 
larger circle.  Offsetting inside creates a smaller one. 
 
 
To start the OFFSET command, type offset, <enter> at the command prompt, or select Offset 
from the Modify menu, or select the offset icon from the toolbar.  At the prompt, Specify offset 
distance or [Through] <current>: you can enter a specific offset distance or type t or through for 
AutoCAD to prompt you for a point through which the offset will go through.  The value of <current> will 
contain either the previous distance or Through if the last OFFSET command used a through point. 
 

 
In the bransonAML drawing, offset the south property line of parcel 22332 to go through the midpoint of 
the east property line.  First, set an undo mark.  Select the offset icon on the toolbar and type t, <enter> on 
the command line.   
 
Select the south property line and you will be prompted Specify through point:.  With osnaps on with 
Midpoint enabled, move the cursor over the east property line until it snaps on to the midpoint.   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

At this point, the OFFSET is still active asking you to Select object to offset or <exit>:.  Offset the east 
property line through the midpoint of the north property line, then exit OFFSET.  Notice that the offset 
lines do not have their endpoints intersect the perpendicular property lines at their midpoints.  They either 
overshoot or undershoot.  We will correct this in the next section on the TRIM and EXTEND commands. 
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Trimming and Extending Objects 
 
You can cut an object precisely at an edge defined by one or more objects.  Objects you define as the 
boundary edges or cutting edges do not have to intersect the object being trimmed; you can trim back to an 
implied intersection.  Cutting edges can be lines, arcs, circles, polylines, ellipses, splines, xlines, rays, and 
viewports in paper space.  Wide polylines are cut along their centerline.  
 
You can extend objects so they end precisely at a boundary defined by other objects.  You can also extend 
objects to where they would intersect a boundary.  This is called extending to an implied boundary.  Valid 
boundary objects include 2D and 3D polylines, arcs, circles, ellipses, floating viewports, lines, rays, 
regions, splines, text, and xlines. Objects that you can extend include arcs, elliptical arcs, lines, open 2D 
and 3D polylines, and rays. 
 

 
To start trim, type trim, <enter> at the command prompt, or select Trim from the Modify menu, or click on 
the trim icon on the toolbar.  You are then prompted to Select cutting edges ... Select objects:.  Using the 
pointing device, pick the objects you want to use as the cutting edge(s).  When finished selecting the 
cutting edge(s), hit <enter> and you are prompted to Select object to trim or [Project/Edge/Undo]:.  
AutoCAD repeats the prompt for the object to trim so that you can trim multiple objects.  Pressing <enter> 
ends the command.  If the selection point is between the end of the object and a cutting edge, TRIM 
removes the portion of the object that extends beyond the cutting edge.  If the selection point is between 
two cutting edges, the portion between is deleted and the portions outside are preserved, turning one object 
into two.  
 
AutoCAD trims 2D polylines at their center lines.  If the polyline is tapered, the width at the cutting edge is 
the same after trimming.  The ends of a wide polyline are always square.  Cutting a wide polyline at an 
angle causes portions of the end to extend beyond the cutting edge.  Trimming a spline-fit polyline removes 
the curve-fit information and changes the spline-fit segments into ordinary polyline segments. 
 
 
Going back to the bransonAML drawing, zoom in on the intersection at the midpoint of the east property 
line. Select the trim icon and pick the east property line as the cutting edge.  

 
 
 

        
 
 
 
 
 
Hit <enter>, pick the end of the line protruding east of the east property line, then hit <enter> to end the 
command.  Repeat for the intersection at the midpoint of the south property line. 
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Zoom out so that you can see the entire 40-acre parcel number 22332.  Click on the west property line.  
Oops, it is a long polyline that we need to break at the intersections of the south and north property lines.  
Do this now using the apparent intersection osnap and the BREAK command using @.  Now zoom in on 
the midpoint area of the west property line.  You can see that the line we offset does not extend completely 
to the west property line.  We need to use the EXTEND command to extend this line.   

 
 
 
 
To start extend, type extend, <enter> at the command prompt, or select Extend from the Modify 
menu, or click on the extend icon on the toolbar.  You are then prompted to Select boundary edges 
... Select objects:.  Using the pointing device, pick the objects you want to use as the boundary 
edge(s).  If you want to select all objects as potential boundaries, press <enter>.  When you are finished 
selecting the boundary edge(s), hit <enter> and you are prompted to Select object to extend or 
[Project/Edge/Undo]:.  AutoCAD repeats the prompt for the object to trim so that you can extend multiple 
objects.  Pressing <enter> ends the command.   
 
If you select a 2D polyline as a boundary object, AutoCAD ignores its width and extends objects to the 
center line of the polyline.  Extending a spline-fit polyline adds a new vertex to the control frame for the 
polyline.  If you extend a tapered polyline segment, AutoCAD corrects the width of the extended end to 
continue its original taper to the new endpoint.  If this causes the segment to have a negative ending width, 
the ending width becomes zero.  
 
 
Now, back to the drawing.  
Select the extend icon and pick 
the west property line as the 
boundary edge. 
 
   
       
 
 
 
 
Hit <enter>, pick the end of the offset line, then hit <enter> to end the command.  Repeat for the area 
around the midpoint of the north property line.  You have now divided this 40-acre tract into four 10-acre 
tracts.  We know that the east end of the east-west line and the south end of the north-south line intersect 
the respective property lines at their midpoints.  But do the opposite ends intersect their respective property 
line midpoints?  Zoom out so that you can see the entire parcel.  Select both the west and north property 
lines and click on the Properties icon.  Notice that they are both polylines.  Polylines do not have a 
midpoint control point, so we need to reduce these polylines to simple lines.  We do that with the 
EXPLODE command which will be covered in the next section.  Before we do that, we need to look at 
some other trim and extend concepts. 
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Trimming to an Implied Intersection 
 
An implied intersection is the point where two objects would intersect if they were extended. You can trim 
objects using their implied intersection as the cutting edge.  To illustrate this, use Quick Select to find 
parcel number 11545.  Zoom to the southwest corner of the property where the road makes a right angle 
from west to north.   
 
 
 
 
 
 
 
 
Launch the TRIM command and select the south boundary of the parcel.  Hit <enter> and at the Select 
object to trim or [Project/Edge/Undo]: type e, <enter>.  At the next prompt, Enter an implied edge 
extension mode [Extend/ No extend] <current>:, type e, <enter>.  The value for <current> will be the 
existing mode of extend.  At the next prompt, Select object to trim or [Project/Edge/Undo]:, pick a point on 
the west boundary of the road that is south of the implied intersection with the south boundary of the 
parcel.  Hit <enter> to end the command.   

 
 
 
 
 
 
 

Trimming to the Nearest Intersection 
 
 
You can trim objects to their nearest intersection with other objects.  When you select the objects to trim, 
AutoCAD automatically chooses the nearest selected objects as cutting edges.  In the drawing, zoom to the 
intersection in the southeast corner of the drawing.   
 
Start the TRIM command and select the intersection with a crossing selection.  Remove from the selection 
set the two parcel boundaries.  Hit <enter> and at the Select object to trim or [Project/Edge/Undo]: type e, 
<enter>.  At the next prompt, Enter an implied edge extension mode [Extend/ No extend] <current>:, type 
n, <enter>.  If the value for <current> is No extend, just hit <enter>.  At the next prompt, Select object to 
trim or [Project/Edge/Undo]:, pick a point on each road boundary line in the intersection.  Hit <enter> to 
end the command.   

  
    
 
       

       1 

2 

3 

4 



 61 

Extending to an Implied Boundary 
 
In the drawing, zoom to the southeast corner of parcel 11545.   

 
 
Launch the EXTEND command and select the west boundary of HIWASSEE ROAD as the extend 
boundary.  At the Select object to extend or [Project/Edge/Undo]: prompt, type e, <enter>.  At the next 
prompt, Enter an implied edge extension mode [Extend/No extend] <current>:, set the mode to extend, hit 
<enter>.  At the Select object to extend or [Project/Edge/Undo]: prompt, select the south boundary of the 
east-west road.  Hit <enter> to end the command. 

 
 
Exploding Objects 
 
Exploding objects converts single objects to their constituent parts but has no visible effect.  For example, 
exploding forms simple lines and arcs from polylines, rectangles, donuts, and polygons.  It replaces a block 
reference or associative dimension with copies of the simple objects that compose the block or dimension.  
Groups explode into their member objects or into other groups.  
An exploded object doesn't look any different, but the colors, linetypes, and lineweights of objects can 
change.  Component objects of a block assume their original properties.  When you explode a polyline, 
AutoCAD discards the associated width information.  The resulting lines and arcs follow the polyline's 
centerline.  If you explode a block that contains a polyline, you need to explode the polyline separately.  
However, a non-uniformly scaled block can be exploded during an insert.  If you explode a donut, its width 
becomes 0. 
 
Blocks inserted with unequal X, Y, and Z scale factors may explode into unexpected objects.  You cannot 
explode xrefs and their dependent blocks.  If you explode a block with attributes, the attributes are deleted, 
but the attribute definitions from which they were created remain.  The attribute values and any 
modifications made by the ATTEDIT command are lost.  For more information, see EXPLODE in 
AutoCAD help . 
 

 
To launch the EXPLODE command, type explode, <enter> at the command prompt, or select Explode 
from the Modify menu, or click on the explode icon on the toolbar. 
        
In the drawing, start the EXPLODE command and at the Select objects: prompt select the two polylines 
representing the west and north property lines.  Once selected, hit <enter>.  Re-select the two lines and note 
that they each have a midpoint control point.  If the Properties window is still open they should be 
identified as lines. 
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Editing Objects with Grips 
 
 
 
Now we can answer the question posed earlier about whether the west and north endpoints of the dividing 
lines intersects the property lines at the midpoint of their respective lines.  Zoom in on the area around the 
midpoint of the west line.  Select both the offset line and the property line.  Do their grips match up?  Zoom 
in closer.  You will see that they do not.     

 
 
 
  
 
 
 
  
 

 
Select the grip of the endpoint of the offset line to make it active and stretch it toward the midpoint grip of 
the west property line until it snaps onto the grip.  Note the difference of the snap when osnap (midpoint) is 
turned on versus off.  Repeat this operation for the north line. 

 
 
Copying Objects 
 
You can copy single or multiple objects within the current drawing, and you can copy between drawings or 
applications.  
 
Copying within a Drawing 
 

 
To copy objects within a drawing, create a selection set and specify a starting point (base point0 and an 
endpoint (second point of displacement) for the copy.  To start the COPY command, type copy, <enter> at 
the command prompt, or select Copy from the Modify menu, or click on the copy icon on the toolbar.  
Select the objects you want to copy and when finished, hit <enter>.  At the next prompt, Specify base point 
or displacement, or [Multiple]:, select the base point of the object(s) or, if you want to make multiple 
copies of the selection set, type m, <enter>.  For making a single copy of the selection set, after you have 
selected the base point you will be prompted to Specify second point of displacement or <use first point as 
displacement>:.  At this prompt, pick the location of the base point for the copy of the selection set.  If you 
are making multiple copies of the selection set, you will be prompted to Select base point:.  Select the base 
point of the selection set and you will be prompted to Specify second point of displacement or <use first 
point as displacement>:.  At this prompt, pick the locations of the copies of the selection set.  When 
finished, hit <enter>.  A short cut to the COPY command, select the objects to copy, right-click in the 
drawing area, and choose Copy Selection from the cursor menu.   
 
In the bransonAML drawing, copy the internal lines, which divide the 40-acre tract. 
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Select the copy icon from the toolbar and select both of the lines.  

 
 
 
Choose the intersection as the base point and displace the copy to a blank area of the screen.  
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Moving Objects 
 

 
You can move objects around with out changing orientation or size.  You can use snap, coordinates, grips, 
and object snap modes to move objects with precision.  Start the MOVE command by typing move, 
<enter> at the command line, or select Move from the Modify menu, or click on the move icon on the 
Modify toolbar.  You will be prompted to create a selection set and when finished hit <enter>.  Next you 
will be prompted to Specify base point or displacement:.  Select the base point using any one of several 
modes.  After making the selection you will be prompted to Specify second point of displacement or <use 
first point as displacement>:.  Select the point at which you want to insert the selection set. 
 
In the drawing, move the lines we just copied to parcel number 21945 to be used to divide that parcel into 
10-acre tracts.  Insert the south endpoint of the two lines at the midpoint of the south boundary of parcel 
21945.  Select the move icon on the toolbar and select the two lines to move. 
 

 
 
 
With running osnaps(endpoint, midpoint) on, pick the base point as the south endpoint of the selection set 
followed by picking the midpoint of the south boundary line of the parcel. 
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Rotating Objects 
 
You rotate objects by choosing a base point and a relative or absolute rotation angle.  Specify a relative 
angle to rotate the object from its current orientation around the base point by that angle.  Whether the 
objects are rotated counterclockwise or clockwise depends on the Direction Control setting in the Units 
Control dialog box.  From the Format menu, select Units. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
You can also specify absolute angles to rotate objects from the current angle to a new absolute angle.  

 
 
Start the ROTATE command by typing rotate, <enter> at the command line, or select Rotate from the 
Modify menu, or click on the rotate icon on the Modify toolbar.  You will be prompted to create a selection 
set and when finished hit <enter>.  Next you will be prompted to Specify base point:.  Select the base point 
using any one of several modes.  After making the selection you will be prompted to Specify rotation angle 
or [Reference]:.  If you want to rotate the selection set a given angle around the base point relative to the 
direction in the Direction Control dialog box , type the angle on the command line and hit <enter> or use 
the rubber-band cursor to rotate the set to the desired position and left-click.  As a shortcut, select the 
objects to rotate, right-click and select rotate from the cursor menu. 
 
In the drawing, rotate the text “SPOIL AREA” 30 degrees counterclockwise.  Select the rotate icon, select 
the text, right-click, select the base point, type 30 and hit <enter>. 
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Scaling Objects 
 
You scale selection sets using the same scaling factor in the X and Y directions.  Thus, you can make an 
object larger or smaller, but you cannot alter its aspect ratio.  You can scale it by specifying a base point 
and a length, which is used as a scale factor based on the current drawing units, or by entering a scale factor 
directly.  You can also specify the current length and a new length for the object. 

 
 
Start the SCALE command by typing scale, <enter> at the command line, or select Scale from the Modify 
menu, or click on the scale icon on the Modify toolbar.  You will be prompted to create a selection set and 
when finished hit <enter>.  Next you will be prompted to Specify base point:.  Select the base point using 
any one of several modes.  After making the selection you will be prompted to Specify scale factor or 
[Reference]:.  If you want to scale the selection set a given scale factor around the base point, type the scale 
factor on the command line and hit <enter>.   Scaling by a scale factor changes all dimensions of the 
selected object.  A scale factor greater than 1 enlarges the object.  A scale factor less than 1 shrinks the 
object.  As a shortcut, select the objects to scale, right-click and select scale from the cursor menu. 
 
In the drawing, scale the text “SPOIL AREA” 1.5 times its current text size.  Select the scale icon, select 
the text, right-click, select the base point, type 1.5 and hit <enter>. 
 

 
 
  
  
 
 
When you scale by reference, you use the size of an existing object as a reference for the new size. At the 
Specify scale factor or [Reference]: prompt, type r, <enter> or right-click and select reference from the 
cursor menu.  To scale by reference, specify the current scale and then the new scale length.  For example, 
if one side of an object is 4.8 units long and you want to expand it to 7.5 units, use 4.8 as the reference 
length and 7.5 as the new length.  You can also specify the reference length by selecting a base point and 
two reference points and dragging to specify the new scale.  A quick way to change the length of open 
objects such as lines, arcs, polylines, elliptical arcs, and splines is to lengthen them (see the next section on 
lengthening objects). 
 
You can use the Reference option to scale an entire drawing.  For example, use this option when the 
original drawing units are inappropriate.  Select all objects in the drawing. Then use Reference to select two 
points and specify the intended distance.  All the objects in the drawing are scaled accordingly. 
 
Change the scale of the bransonAML drawing from feet to meters.  Be sure to thaw all layers.   Draw a 
horizontal line 1000 feet long in the view.  Start the SCALE command, type all, hit <enter>.  At the prompt 
Specify base point:, type 0,0 and hit <enter>.  At the Specify scale factor or [Reference]: prompt, type r, 
<enter> or right-click and select reference from the cursor menu.   
At the Specify reference length <1>: prompt, with osnap(endpoint) on, left-click on one end of the 1000 
foot line and at the Specify second point: prompt left-click on the other end.  At the Specify new length: 
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prompt, type 304.8 and hit <enter>.  There are 304.8 meters in 1000 feet.  In order to see the re-scaled 
drawing,  type z , <enter>, e, <enter>.  Scale the drawing back to feet. 
      

Mirroring Objects 
 
You can make a mirror image of an object or group of objects.  This is useful for drawing symmetrical 
objects since you only need to draw one-half or one side of the object(s).  You mirror objects around a 
mirror line, which you define with two points.  You can delete or retain the original objects.  Mirroring 
works in any plane parallel to the XY plane of the current UCS. 
 

 
Start the MIRROR command by typing mirror, <enter> at the command line, or select Mirror from the 
Modify menu, or click on the mirror icon on the Modify toolbar.  You will be prompted to create a 
selection set and when finished hit <enter>.  Next you will be prompted to Specify first point of mirror 
line:.  Select the first point of the mirror line.  You will then be prompted to Specify second point of mirror 
line:.  Select the second point of the mirror line.  You will now be prompted Delete source objects? 
[Yes/No] <N>:.  If you want to delete the source objects, type y, <enter> or if you don’t want to delete the 
source objects, hit <enter>.  The new object(s), a mirror image of the source object(s), will be drawn 
reflected around the mirror line you just specified.   
 
When you mirror text, attributes, and attribute definitions, they are reversed or turned upside down in the 
mirrored image.  These mirrored objects are true mirror images of the original section of the object and 
follow the mathematical rules for reflection.  To prevent mirrored text from being reversed or turned upside 
down, set the MIRRTEXT system variable to 0 (off).  By default, MIRRTEXT is set to 1 (on).  If you turn 
it off, the text has the same alignment and justification as before the mirroring. 
 
In the bransonAML drawing, make a mirror image of the intersection in the northeast corner of the drawing 
so that the new curve to the east is identical to the curve to the west.  An easy way to do this is to mirror the 
west curve. 
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Start the mirror command and select the lines that make up the curve and the north and south lines of the 
east-west road plus the text west of the intersection.  After the selection has been made, hit <enter>.  Select 
the mirror line to be the north-south segment of the section line within the intersection.  You may want to 
use your osnaps to make your selection.  After picking the north endpoint as your first mirror line point and 
the south endpoint as your second mirror line point, hit <enter> to retain the source objects.  You will 
notice the new east curve and road is drawn with the text in normal presentation. 
 

 
After observing the effects of mirroring objects, undo any objects that were mirrored. 
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Editing Polylines 
 
You can edit polylines by closing and opening them and by moving, adding, or deleting individual vertices.  
You can straighten the polyline between any two vertices and toggle the linetype so that a dash appears 
before and after each vertex.  You can set a uniform width for the entire polyline or control the width of 
each segment.  You can also create a linear approximation of a spline from a polyline.  Of the various 
options or modes available within the PEDIT command, the ones you will most likely use are Close, Open, 
Join, and Width.  You may want to explore the Edit Vertex mode to see the versatility this offers in editing 
polylines.   
 
 The Close option creates the closing segment of the polyline, connecting the last segment with the first.  
AutoCAD considers the polyline open unless you close it using the Close option.  The Open option 
removes the closing segment of the polyline.  AutoCAD considers the polyline closed unless you open it 
using the Open option.  The Join option adds lines, arcs, or polylines to the end of an open polyline and 
removes the curve fitting from a curve-fit polyline.  For objects to join the polyline, their endpoints must 
touch.  The Width option specifies a new uniform width for the entire polyline.  You can use the Width 
option of the Edit Vertex mode to change the starting and ending widths of a segment. 
 

 
Start the PEDIT command by typing pedit, <enter> at the command line, or select pedit from the Modify 
menu, or click on the pedit icon on the Modify toolbar.  You will be prompted to select a polyline.  When 
the line is selected, AutoCAD will respond Object selected is not a polyline Do you want to turn it into 
one? <Y> if the line is not a polyline.  If you type n, <enter>, AutoCAD will prompt you to select a 
different polyline.  If you accept the default <Y>, and hit <enter>, AutoCAD will turn the line into a 
polyline and respond with Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype 
gen/Undo]: which is the same prompt it would have displayed if you had selected a polyline initially.  At 
this point, type the capitalized letter of the option desired or right-click the pointing device in the drawing 
space and select from the cursor menu. 
 
In the bransonAML drawing, go to tract # 22332 and use the Close, Open, Join and Width options to edit 
the lines defining the boundaries of the parcels.   
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Editing Text 
 
One of easiest ways of editing text is to use the Properties dialog box.  Select the Properties icon from the 
toolbar and a text object from the drawing.  For example, in the 22332 parcel, select the text BRANSON.   

 
 
 
All the editable attributes of this text object are shown here and can be easily changed.  If you only 
want to change the contents of the text object, you can use the Text... option on the Modify menu or 
the Edit Text icon on the toolbar.   
 

X. Q&A  
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